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Introduction 

 
This document was written to be used as a printed 
booklet. You are strongly recommended to refer to a 
paper copy, rather than trying to learn the features 
described while you are reading it online. 

Access is designed for work which involves manipulating and sorting 
data records of any kind. You can create queries to sort and filter 
your data, and use reports to produce attractive, formatted 
printouts. You can set up forms to make data entry more "user-
friendly", and include checks to validate the data as it's entered.  

 Jargon: database 
Simply a collecion of 
information. This 
could be a list of 
addresses, catologue 
of products, medical 
records ... 

Data in one Access table can be linked with data in another. This is 
what relational database management means. If two tables of data 
have a common field – a shared item of information – you can 
hook them together, then query and report on them in combination. 

You can import and export data tables between Access and older 
standard database software, such as dBASE; spreadsheet software, 
including Excel and Lotus 1-2-3; and html (Web page) format. 

This document sets out to provide the information which 
is most commonly needed by people who are using 
Access in an academic or office context. It assumes that you 
are familiar with the Windows interface, and with basics such as 
opening and saving files. You'll find it much easier to learn Access if 
you are acquainted with using Word before moving on to spreadsheet 
work. Microsoft have designed all the Office applications so that 
they are as similar as possible. Common menu items will be found in 
the same place; text and data are for the most part edited, cut and 
pasted in the same way. 

These instructions are based on the Access 2002 user interface. 
Access 2003 is identical as far as the features described here are 
concerned. If you have an earlier version, for most purposes there are 
no compelling reasons to upgrade to Access 2003 if you already have 
Access 97, 2000 or 2002 on your home computer.  

Where things are different in the Access 97 and 2002/3 versions, this 
is flagged in the course of the document. Margin notes are used to 
highlight significant Access 97 differences. Access 2000 is like 97 in 
some respects and like 2002 in others. 

Transferring files between different versions of 
Access: Access 2000/2002/2003 are set by default to use the 
Access 2000 file format. If this setting has been changed, 
before you copy your file for transfer, you will need to use the 
Convert Database utility, available from Tools | Utilities in 
the Access menu. Conversion to Access 2000 format creates a 
file which will open in all versions from 2000-2003. There is 
also an Access 97 format option available. See page 31. 
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Basic operations and concepts 
The Task Pane (illustrated 
below) was  a much-
proclaimed new feature in 
Office 2002 software. But in 
Access, it doesn't figure 
prominently once you have 
a database file open. 

 Load Access. 
Your first step when Access has loaded is either to open an existing 
database, or create a new one. In Access 2002/3, this is done from 
the Task Pane on the right of the screen. 

Access provides some excellent sample databases: in combination 
with on-line help, these provide a good way of getting a feel for what 
Access can do. The Northwind sample database is especially popular 
- it has been available in all versions of Access from 97 onwards. 

 Access 2002/3: from the Help menu, select Sample 
Databases, then Northwind Sample Database. If the file 
can't be found, you may need to return to your installation CD 
to install the sample database. In all versions of Access from 
97-2003, the default file location of the Northwind database is 
C:\Program Files\Microsoft Office\Office\Samples. Copy 
Northwind.mdb to another location before you modify it in 
any way, so the original remains unaltered. (Note: be sure the 
file you copy is Northwind.mdb – not Northwind.adp.) 

 If you're using the Northwind sample and a main switchboard 
window opens, click the X in the top right corner of this window 
to close it - the database itself will stay open. 

Once you've opened a database, take a look at the menu and toolbar.  

 

These are context-sensitive – what’s available changes depending on 
what you are currently doing. If a tool or menu option is greyed-out, 
it's because you haven't yet done anything which might require its use.  

 Move the cursor slowly over the toolbar icons. Whether or not 
they're greyed-out, a tool tips box pops up to describe the 
function of the tool which the cursor is currently resting on.  

 Now look at the database window. This is your Access 
“database control centre”. 

 Open and explore some of the tables, queries, forms and 
reports in the Northwind database.  

 Press F11 to return quickly from whatever you're doing to the 
Database Window. 

 On your own computer, you can customise the toolbar to 
include the menu items you use most commonly. To find out 
how, look up toolbar in Access online help.  
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Using Access online help 

Access 2002/2003 has an Ask a Question box top right of the screen. 
1. Type a question - or just a keyword - into the box, then press 

enter. A list of topics will appear.  

2. Select a topic, and the Access Help window will open, 
with information on the selected topic displayed. Click on any 
blue text for more information about that sub-topic. 

In earlier versions of Access, use the Help menu to access this window. 

3. Notice the tabs at the top left of the Help window. Answer 
Wizard and Index provide two different ways in to the same 
help which is available from the Ask a Question box. 
Generally, it's quickest to use the Index if you're familiar with 
Access terminology, whilst the Answer Wizard is more likely 

to locate the help you need 
when you don't know the 
jargon. 
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4. Contents Help can be useful if 
you want tutorial-type help on a 
specific topic. Click the Contents 
tab, then click the + icon to 
expand the Contents list. The 
example page illustrated - About 
Designing a Database - provides 
a valuable introduction to 
general principles. 

  

Managing your work 

 An Access database is a single file which can 
contain a set of database tables, as well as all the 
related queries, forms and reports. 

 Access will not perform well if you work straight 
from a floppy disk, or from a USB storage device 
with only limited space available. On centrally-
administered networked computers, it's generally best to work 
from your network homespace.  

 Make regular backup copies of important files. Access 
databases do sometimes become unnecessarily large, and 
occasionally corrupt - you should be aware of the utility which 
is available for compacting and repairing them. See page 36. 



Creating a Database 
Before you start entering data into an Access database, you need to: 

1. Plan your database structure on paper. 
2. Create a new Access database file, name and save it. 
3. Create your table or tables, name and save them. 
4. Test your table structure with some sample data, and modify 

the structure as required. 

Planning your Database 

 Tables are the one essential ingredient of a 
database: you can't create queries, forms or reports 
until you have a table or set of tables to work with. 

 
Think and plan before you go any further. All good 
database designers work out their database 
structure with a pencil and paper first. 

You may already have some data in mind which you want to use. If 
not, follow the Book Catalogue example which is used here.  

Your task at this stage is to decide on what the different data items 
are, and allocate each of them a field or column in the table. Initially 
our example database will include just one table – a booklist 
containing author, title, publisher, publication date and summary.  

If you just wanted to use this database as a bibliography, the one table 
would be all you needed. But if you were a bookseller, at the planning 
stage you would decide that for ordering purposes you needed another 
table as well, containing publisher's addresses. Because Access is a 
relational database management system, the booklist and publisher 
tables can be linked to one another via the common field containing 
the publisher's name. The design and use of relational databases is a 
major topic in its own right, and this document doesn't attempt to do 
more than supply some initial pointers (page 34). 

 
It's easy to add extra fields to a table later, if you 
find you've left something out. But it's much more 
difficult if you decide that you want to split up 
information you've entered in one field.  

A common example of this is when people create a database address 
book, and then kick themselves because they have entered Firstname 
and Lastname as one field, in that order - for example "John Smith". 
This makes it impossible to sort alphabetically by lastname. General 
good practice is to create separate fields for firstname and lastname. 
However, in our example database this would create a dilemma - some 
books are written by more than one author. As a working compromise, 
author has been kept as one field, but with lastname entered first, 
followed by firstname or initials as given on the book cover.  
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Creating your file 

1. Close any sample databases you have open. (From the File 
menu, select Close; or click the X in the top right corner of 
the database window.)  

2. If the Task Pane (page 4) isn't visible, click on the New 
button in the Toolbar. The Task Pane will then appear. (Or, 
in Access 97/2000, the New Database window.) 

3. Click Blank Database. (In Access 2000, just Database.) The 
File New Database window will open. You can't start 
working with an Access database until you have named and 
saved it: make sure you set Save in to an appropriate folder, 
and give your file a meaningful name. Spaces in filenames are 
best avoided. Your filename will automatically be given the 
extension ".MDB": if you called your file "Test", it would 
appear in any file listing as TEST.MDB. 

4. When you have named your file, click on Create. An empty 
database window will appear. 

You may be surprised by the amount of time which Access takes to 
create this empty database file on your disk (especially if - against 
heartfelt recommendations - you're working straight from floppy). 
This is because the structure of an Access database file is highly 
sophisticated. It has to be capable of containing all the database 
objects – tables, queries, and so on – which you may wish to create. 

In the database 
window, notice 
the various 
different types of 
database objects 
which your file 
could contain. 

Creating a Table 

You can choose from a variety of ways to create your table. The 
author thinks that using Design View is the clearest way to learn. 

1. In the database window, make sure the 
Tables tab is selected. 

2. Double-click Create table in Design 
View. (In Access 97/2000, click the New 
button, then select Design View.) 

3. A table design window opens. You 
aren't entering your table data yet – first, 
you specify the table structure. 

You should have decided by now 
what fields your table is to include. 
The illustration shows what the top 
part of the design window will look 
like when the fields have been set up 
for our example table.  

For each field in your table, there are three pieces of information to 
enter: Field Name, Data Type, and Description. Click with the 
mouse or use the tab key to move from one to the next. 

At the bottom right of 
the table design 
window, the blue help 
text is worth reading. 
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Field Name 
These can be up to 64 characters long. Names can include spaces, but 
these may cause problems with some kinds of advanced database 
work. Try to make field names meaningful without being too long. If a 
field name is much longer than the field size (page 11), it makes tidy 
screen displays and reports more difficult. 

Data Type 
You need to tell Access what type of data you plan to store in a 
particular field: for instance text, numbers and images all need to be 
handled by Access in different ways.  

 Click in the Data Type column. Click on the arrow button 
which appears, and select from the Data Type popup. 

The data types to choose from include all those familiar to users of 
other database software or earlier Access versions, plus a few more.  
Text: the default – what you get if you don't change it. Maximum 
length is 255 characters. If you won't need to sort on the field, and it 
will contain more than around 80 characters, it's may be best to define 
it as a Memo. 
Memo: this can include text entries of any length. People often want 
to store whole documents within a database. Using a memo field, you 
can only store simple, unformatted text, and you can't index or sort 
on the field. Formatted documents can be stored as OLE objects.  
Number: Note that there are some occasions when numbers are 
better treated as text than defined with the Number data type. Use the 
Text data type where numbers are not to be used in any kind of 
calculations – for instance telephone numbers. 
Date/Time:  The Date data type isn't appropriate for a simple year 
date, such as Year of Publication in our sample table.  Use it when 
you want to enter day-month-year, or time, in a standard format. 
Currency: You'll automatically get figures entered in £ format if 
you select this data type. If you want Euros, modify field properties 
as described on page 11. 
AutoNumber: Use where you want a field which automatically 
gives a unique record number to each table entry. 
Yes/No: Use for "logical", True/False, "flag fields". 
OLE Object: Use to store graphics, charts, formatted documents, 
sound files in the table. See page 36. 
Hyperlink: Use to store links to other files or to Web pages. 
Lookup Wizard: Use to create a field which lets you choose a 
value from another table, or from a list or query you've set up. 
Online help contains more detailed information about the data types 
available in Access. Click in the Data Type column, then click F1. 

Field Description 
This is optional. Use to clarify what data is to be entered in the field. 
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Saving your Table 

You will be able to return to the design window if, once you've 
started entering data, you find you need to make changes. Before you 
can enter any data, you must name and save the table. 

 In the Toolbar, click the Save button. 
A "Save As" box will appear. The name for your table can be up to 64 

characters if you want, but remember it's not a good idea to 
make names too long – it's difficult to display them in the 
Access database window lists. It's good practice to avoid spaces 
in table names – they can cause problems in some contexts. 

Primary keys 

After you have given your table a name, if you haven't defined a 
primary key an Alert Window will ask if you want 
to do so. A primary key is a field which can uniquely 
identify any record in your table. No one field in our 
example booklist table could act as a primary key: for 
instance there may be more than one book by the 
same author.  

If you're creating a relational database, where data contained in 
different tables can be linked, a primary key is essential. Even where 
you aren't doing this, Access functions much better if a primary key 
is defined. Without one, you may to find that when you return to 
your table after entering data, records won't be displayed in the same 
order as you typed them in. This can often be irritating. 

To create a primary key: 
 If you're saving your table without having defined a primary 

key first: click the Yes button when the alert window appears.  
An extra field will automatically be added to your table structure. 
This will be called ID, and will use the Autonumber data type. 
The key symbol by the field name denotes its status as primary 
key. 

 To create a primary key at any other stage: give the field a 
name of your choice, and set Data Type to AutoNumber. Click 
in the button bar left of the field name to select the field row, 
then click the Primary button in the toolbar. 

By default, the autonumber assigned will be 1 for the first record you 
type in, 2 for the next, and so on. When you view the data in your 
table, it will automatically be ordered by the primary key. If you 
delete records, remaining records won't be renumbered – there will 
just be unused numbers in the autosequence. 

As long as each entry is unique, a primary key  doesn't have to use 
the autonumber data type. If it's any other data type, you must set up 
an index on the field which prohibits duplicate values. Do this from 
the Field Properties box - page 11. 
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Modifying the Table Structure 

 
Always regard entering your first few data records, 
as testing your table out. It's much easier to make 
changes early on than to be stuck with an unsatisfactory table 
with a lot of data in it. 

 You can easily shift between datasheet view (to enter your 
data) and design view (to modify your table structure) with 
the View button at the left of the toolbar. 

 Enter a few data records now – see page 12. 

Changing the Field Order 
The order in which fields appear on screen can make a lot of 
difference to entering data easily and scanning records quickly. You 
can always change the order on the screen display or when you're 
creating a Query, Form or Report; but this can prove a lot of 
unnecessary work. In the Table Design Window, you can move any 
field entry to a different position using “drag and drop”: 

Button bar 

"Click and drag" cursor 

1. Click in the button bar to the left of the Field Name. 
The row will be highlighted and marked with an arrow. 

2. Click again in the button bar, and hold down the mouse 
button. The cursor will change to look like the illustration. 

3. Drag to where you want the field placed. 
As you drag, the heavy black line marks where the top of the row 
you're moving will be positioned. Note: the cursor must look like the 
illustration above left, otherwise you may find yourself changing row 
height instead of moving the row. (If this happens, click Undo.) Undo 

Inserting and Deleting Fields 

 To insert a field: In Design view, click in the row below where 
you want a new field. In the Toolbar, click the Insert Rows 
button. A row will be inserted above the one currently selected. 

 To delete a field: In Design view, click in the field you want to 
delete. Then click the Toolbar Delete Rows button. 

Alternatively: right-click in the row, then select Insert Rows or 
Delete Rows from the popup menu. 

Renaming Fields 
You can simply edit any field name as you wish. If you already have 
data in the table, always rename a field as a single operation and save 
your changes to the table at once. If you rename a field at the same 
time as you insert, delete or move fields, you may lose data.  
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Field Properties: Field Size 
Once you have entered a name and data type for each of your fields, 
you have a usable table. But there are ways you could improve its 
design before you start entering data. 

The box at the bottom left of the table design window allows you to 
set a whole range of Field Properties, including formatting, 
default values, validation rules and indexes. It isn't necessary for you 
to worry about most of these, but you do need to give some thought 
to the Size of each field that you create. 

Field Size limits the number of characters allowed for each data 
item in that field. The default for a text field is 50 characters. Make 
sure field size is sufficient for your longest entries, or data may be 
truncated. Field properties box 

Access stores table data in a different and generally more efficient 
way than older types of database software. Setting the minimum 
possible field lengths to keep file size down isn't important in 
Access. However, for the sake of making your table as easy as 
possible to view on screen without having to mess around, it's worth 
making sure that the field size isn't vastly larger than you need. 

To change the size or any other property of a field: 
 Click in the Field whose properties you want to change. The 
Field Properties box will display the values currently specified 
for this field. 

In the Booklist example these changes might be made: 
 Click in the Author field. In the Field Properties box, alter 
Field Size from 50 to 30. 

 You are likely to need more than 50 characters for the Title 
field. Alter Field Size from 50 to 70. 

 25 is probably enough for Publisher Name. 

Number field properties 

If you're changing the properties of a Number field: you specify a 
number setting, rather than specifying how many characters wide the 
field is to be. An arrow appears when you click in the Field Size box: 
this displays a popup of available options. If you're not a mathematician 
you may find these meaningless: don't worry. Usually it's OK to use the 
default setting. The Decimal number 

setting was not  available 
in  Access 97. The Format entry in the Field properties box is mainly used to apply 

different display settings to number fields. 

 Select the field to which you want to apply format properties. 
In the Field Properties box, click in Format, and an arrow 
will appear. Click on this to display a list of the available 
options for the type of field currently selected. 
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Entering Data in a Table 
 Open your table from the Database Window; or if it's open in 

Design view, switch to Datasheet view (page 10).  TIP: 
Access will automatically 
add values in an 
Autonumber primary key 
field. It's often easiest to 
change field order (page 
8) so autonumber fields 
are at the end, and thus 
don't get in your way 
when entering data. 

 Start entering some records.  
 Press Enter, or use the Tab key, to move from one field to the 

next. 
 Be consistent about where you use capital letters, how you 

punctuate and abbreviate, and so on. 
 Edit record data just as you would edit text in Word. 
 Deleting records: Click in the Row bar to highlight the 

record or records you want to delete, then use the keyboard 
delete button or toolbar cut icon. Important: once you 
have deleted a record, you can't undo your action. 

 Access saves each record as you enter it into the 
table, whether you do this from a Form, or from the standard 
datasheet format. So you don't need to worry about 
saving records as you go along. 

Adjusting field display widths 
You'll often want to adjust the display width which Access has 
allocated automatically for each field. To change the screen width of 
a field: 

1. In the Column bar, position the mouse cursor on the 
dividing line to the right of the field whose width you want to 
alter. When the cursor changes to a "double arrow" shape: 

2. Click and drag until the field display is the width you want. 
Double-clicking will automatically size to fit the longest entry. 

Note that this doesn't change the actual field size. (See page 11.) It 
simply changes how much of the field you can see on screen.  

When you type in a field entry which is longer than can be displayed 
within the screen field width, your text will scroll along within the 
space available. Use the Home and End keys (right of keyboard) to 
move to the beginning or end of this field entry. 

Row bar 

Set row height in the 
same way by clicking and 
dragging when the mouse 
is over a row separator 
bar. Changes will be 
applied to the whole table. 

Column bar 

Most especially when you include memo fields, such as the Summary 
field in the example booklist table, you'll see the disadvantages of 
entering any more than a few words of text when using the datasheet 
entry format. For tables which include memo fields, or with a large 
number of fields, it's usually easiest to create a form for data entry. 
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Using a Form for entering Data 

Forms are often a more user-friendly way of entering data than using 
datasheet view. The quickest way to create a form is to start with an 
Autoform, and then modify it if you need to. If you want something 
entirely different from the standard Autoform layout, you can either 
use the Form Wizards, or start from scratch with a blank form. 

1. Make sure the table you want to create a form for is open in 
Datasheet view, or selected in the Database Window. 

2. In the Toolbar, click on the arrow by New Object. 
The popup menu displays all the object types which you can create. 

3. Select Autoform, and a form will be instantly created. 

The space allocated to each data item will reflect the data types and 
field sizes you specified in your table design (page 11). 

 Use the tab key, the arrow key, or the mouse to move 
between one field and the next while entering data. 
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 When you create a form in Access 2002/3, a 
formatting toolbar appears below the menu. Items 
you can change from here include typeface, 
background colour and borders. To modify form 
layout: see page 27.  

 When you're happy with your layout, Save the Form. 
The name can be up to 64 characters long. 

 Use the video buttons at the bottom left of the form window 
to move backwards and forwards through any records you 
have already entered. (Note that these keys are also available 
from the standard datasheet table window.) 

New record 

First record Next record 

Previous record Last record 

 To create new records: click the new record button. 

The Form Wizard 

You may want a different type of form layout from the one 
which Autoform gives you. If so: 
1. Select Form instead of Autoform from the New Object 

menu. If you now select Design View, you won't have a 
wizard to help you and will almost certainly have no idea 
what you should do! Form Wizard is usually the choice 
you want. From here, you can be selective about what 
fields to include in your form – for example, you might 
not wish to display an autonumber field, which the user 
can't change. The standard columnar layout looks like the 
Booklist example illustrated above: one field per line. 

Add all fields to the form with the >> 
button. Add or remove fields one by one 
with the > or < buttons. 

2. Follow through the Form Wizard steps by clicking the 
Next button. You can select from a variety of layouts and 
styles – choose standard if you want something simple. 



Finding, Sorting, Filtering and Querying 
If you've created a simple example table, it's likely to contain only a 
handful of records. "Real-life" databases will usually contain 
hundreds or thousands of records. The database user will want to 
instantly find particular records in a table; to order or sort the records 
in a variety of different ways; and to filter so that only records which 
meet a set of conditions or criteria are displayed.  

Finding specific records 

With your table open in either Datasheet or Form view: 
1. Click in the field which will contain what you're looking for. 

2. In the Toolbar, click on the Find button. 
The Find dialog window will appear. Click and drag on the title bar to 
move the window so you can see your data properly while you're 
using it. 

3. Enter what you're looking for in the Find What box. 
4. By default, Access will only search in the active 

field (where the Insertion Point is currently 
placed). To search in all fields, click the arrow 
by the Look In box. Change the setting from 
the current field name to the table name.  

5. Click on the arrow button by the Match box, 
and make sure you select the appropriate 
option. If you leave this set on Whole Field, in 
the example it would only find books with the 
specific title "Women", not books whose title 
contained the word "Women". 

Access 97: If you want to 
search in all fields, uncheck the 
Search Only Current Field box. 
In 97, Find First is a separate 
choice from Find Next.  

6.  To find only instances where capitalisation matches what 
you've entered in the Find What box, click on Match Case. 

7. Check that settings are as you require, then click on Find 
Next. The first record matching your search conditions will be 
highlighted. Click Find Next again to locate further matches. 

Carry out as many searches as you want before closing the Find box. 

Quick sorts 

1. Open the table which you want to filter or sort, either in 
Datasheet or Form view. 

2. Click in the column you want to sort on. In our example, you 
would click in the Author column if you wanted to sort the 
booklist alphabetically by author’s name. 

3. In the Toolbar, click on the Sort Ascending or Sort 
Descending button. 
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Using filters 
Filter by 
selection 

Apply/ Remove 
filter 

Filter by 
form 

Using the Find tool picks out records one by one which contain the 
text or data you have specified. Sorting reorders the whole of your 
table. Filtering displays only the records which meet specified 
conditions. 

Filter by selection 
In our example table, a bookseller might want to display only the 
books published by one particular publisher. Filter by selection offers 
a very quick way to do this kind of thing. 

1. In your table, highlight an instance of the data value you want 
to filter by – Penguin in our example. 

2. In the Toolbar, click the Filter by selection button. 
Only records containing the data you had selected, in the same 
column that you had selected within, will now be displayed. 

3. To return to viewing all records: in the Toolbar, click 
Apply/Remove filter. 

Filter by form 
This lets you apply filters involving more than one field, or using 
operators: equals, greater than, less than.  

1. In the Toolbar, click the Filter by form button. 
2. Click within a column. If you want to select your filtering 

condition from all the values which have been entered in the 
field, click the arrow button which appears. Or, use 
comparison operators – see the next page. In the example, the 
filter will show only books published by Penguin after 1980. 

More sophisticated filtering conditions can be used just as in a query 
– see pages 19-20. 

3. To apply the filter: in the Toolbar, click Apply filter. Click 
the same button again to remove it. 

The last filter you used will automatically be saved with your table 
and can be reapplied when you next open it, but other filters 
previously used will be lost when you close a table. If you want to 
return to a particular ordering or filtering of your data, you can save 
the filter as a query.  

 Click the Filter by Form button so your filter conditions are 
displayed. In the Toolbar, you should notice that the Save 
button has changed to Save as Query. Click the button, give 
your query a name, and OK. 

 To apply a query from the toolbar: click Filter by Form. The 
Toolbar Open button will change to Load from Query.  
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Using Queries 

Queries are used to view, change, and analyze data in different ways. 
There are a variety of different query types, all of which can be 
saved for future use.  

Select queries are the most common type: these provide an easy 
way of picking out and sorting a set of records which you want to 
display together. You can base forms and reports on select queries in 
the same way as on tables. You can also create queries based on other 
queries. In a relational database, a query can refer to more than one 
table. 

Crosstab queries can be used to summarise data from a 
table. In the example illustrated on the left, sales staff enter 
their sales with separate records for each product category. 
Using a crosstab query, sales performance of each member of 
staff can be compared across all product categories. 

Other types of query are all action queries – queries that can make 
changes to a set of records "all in one go". These are normally 
created from select queries. Delete queries are used to delete records 
which meet the conditions you specify; update queries for making 
global changes to a set of records. Make-table creates a new table 
from the results of a query, and is especially useful if you want to 
export data to another database. Append queries let you add records 
from another table which match the conditions you specify. 

Take great care when using Action queries, especially 
Update and Delete. Once you have run an action 
query, you can't undo the changes it will make to your 
table. Don't experiment on important data! 
Store all queries except crosstab queries as select queries, so 
data isn't unintentionally updated or deleted when a query is run. 
See page 22. 

Comparison Operators 
Before you start constructing queries, you should be familiar with the 
standard comparison operators. These are the same as used in Excel, 
dBASE, or any other spreadsheet and database software: 

Operator Meaning Example Records displayed 

= Equal to Penguin All books published by Penguin. 

NOTE: Access will assume that you mean "equal to" if you don't specify any operator. 

< Less than < 1985 All books published before 1985. 

> Greater than > 1985 All books published after 1985. 

>= Greater than or equal to >= 1985 All books published in or after 1985. 

<> Not equal to <> Penguin All books not published by Penguin. 
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Setting up a Query 

 In the Database Window, click the Queries tab. 

You can choose between creating a query using Design View, or 
using one of the Query Wizards. In general, it's easier 
to learn the principles of querying, and often quicker if 
you create your query in Design view. The exception 
to this is creating a crosstab query, which it's best to do 
by using the special Crosstab Wizard - select this by 
clicking on the New button. (In earlier Access 

versions, click the New button to select from all the available create 
query options.)  

Unless the table you want to base your query on is already open, 
Access will ask you what table or query you want to use. If 
necessary, select the table you want from the picklist. 

The Select Query Window will now open. The illustration shows 
just the lefthand side. The fields you require are selected from the 
table picklist at the top of the query window. At the bottom of the 
window is the query grid, where your query is constructed. 

Selecting the Fields to include in your Query 
The first step in designing a query is to decide what fields you need 
to include. You need to include both the fields required to enter 
conditions for the query and the fields whose data you want to 
display - these won't always be the same. 

To add fields one by one: 
 In the table picklist, click on the field name, then drag and 

drop into the Field Row on the query grid. Repeat for every 
field you want to include. 

To add multiple fields at once: 
 If the field names are adjacent in the picklist: click on the first 

field you want (Author in the example), then hold down the 
Shift key while you click on the last field name (Date in the 
example). Click anywhere in the highlighted area, then drag 
and drop into the Field Row. 

 If the field names aren't adjacent: hold down the Control key 
while you click on each one, then drag and drop as above. 

The selected Field Names should now 
lay themselves out as illustrated. 

To remove fields one by one: 
 Select the column or columns in the grid, then delete or cut. 

To clear the query grid and start again: 
 From the Edit menu, select Clear Grid. 
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Specifying the Query Sort Order 

 In the query grid, click in the Sort Box for the field you 
want to order by. Now click on the Arrow Button, and select 
the appropriate Order option. 

You can sort on one field, and within that, on another field. For 
example, a booklist would be likely to contain more than one book 

by some authors. So you might want to 
sort by author and within that by 
publication date, as in this example.  

The sequence in which the fields are displayed in the query will 
decide which is the primary sort field. Consequently, you may 
sometimes need to reorder the fields  on the query grid. Do this by 
clicking on the column bar, then dragging and dropping the field to its 
required position. If you need to use a field to define your sort order, 
but don't want that field displayed, just uncheck the Show tickbox. 

Setting Criteria 

Whether you're creating a query or a filter, you need to understand 
how to set criteria in order to select the data you want displayed. 
The standard comparison operators were introduced on page 16. 
Access also offers a variety of more sophisticated operators, which 
are described on the following pages. 

 In the Query Grid, click in the Criteria box for the field 
where you want to apply a condition. 

You can apply as many criteria as you want within a query. You 
might want these to be And conditions – "Find me all books 

published by Penguin after 
1985" would be an example. 
This is an "And" query 
because it's asking for records 

which meet both of two conditions. (Published by Penguin, and 
published after 1985.) The criteria which need to be entered are 
illustrated above.  

Example 1: And query. 
Access automatically adds 
inverted commas "" around text 
strings within criteria. 

 
Criteria are treated as And conditions when they 
are placed on the same row in the Query Grid. 

 Criteria are treated as Or conditions when they 
are placed on different rows in the Query Grid. 

"Find me all books published by Penguin or Fontana after 1985" 
contains an Or condition. Example 2: Or query. 

Note that the "after 1985" 
condition has to be repeated for 
both publishers.  
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Showing and hiding fields 

When you use a field to set criteria, you won't necessarily want to 
display it. In Example 1 on the previous page, you would give the 
query a title such as "Books published by Penguin" – there's no need 
to display the Publisher in every record. In the Query Grid, uncheck 
the Show tickbox so the field isn't displayed in the query results. 

Using the "Like" operator for "Contains" searches 

An "equal to" comparison operator only works when the string of 
characters you are seeking is exactly the same as the entire contents 
of a field. Database users often wish to search for all records which 
contain a particular string of characters within one field.  

In Access, you use the Like Operator, together with Wildcards, to 
construct "contains" queries. Access uses the wildcards which are 
standard in all Windows software: 

? substitutes for a single character 
*  substitutes for a group of characters 

In our example booklist, you might decide that you wanted to find all 
the books about issues relating to women. However, it wouldn't be 
satisfactory to construct your query simply to select books containing 
the word "women" – if you did this, you would miss out on any 
books whose title contained the word "woman".  

 
You need to give a good deal of thought to 
specifying your query conditions correctly to 
ensure that you get all the relevant data, and only 
the relevant data. 

To resolve this problem in the example, you might choose 
to specify your query as "Find me all the books whose 
title contains Wom" – you'll then pick up both Woman 
and Women with one condition. This is fine as long as 
your booklist doesn't contain books about Wombats as 
well! 

The expression Like *wom?n* will pick out all titles containing 
"woman" or "women", without having to worry that books about 
wombats will also be included.  

If you placed an asterisk at the beginning but not the end 
of "wom?n" (*wom?n), you'd get only the titles which 
finished with these letters. If you placed an asterisk at the 
end but not the beginning (wom?n*), you'd get only the 
titles which started with these letters.  
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Other Useful Operators 

 Between ... And  Use this operator to select all records 
within a particular range, as in this query to find all books 
published between 1985 and 1990: 

 In Operator. Use to select records which have one of a set of 
values. This is often a handy alternative to a lot of Or 
conditions (see page 18). This query would select books 
published by Fontana, Penguin or Methuen: 

To use the In operator, enclose your set of values in brackets 
(), and place a comma between each value in the set. (Access 
automatically adds inverted commas around character values.) 

 And Operator. Use to specify two values as an And 
condition (page 18) within the same field . This query would 
select books where the title contained "Wom" and  contained 
"Industrial": 

 Not Operator. Use to specify an "anything except" condition. 
(For instance Not Like, Not In.) Mix and match conditions as 
you need to. The query below would ensure you didn't pick up 
books about wombats when searching for books about women. 
Warning: Not Like and Not In queries may run very slowly. 

 
Don't forget – you must use Wildcards (page 19) 
when you use the Like Operator. 

 
Access automatically adds inverted commas "" 
around the text strings you specify in a query, and 
capitalises the first letters of operator names. 

 If you use And queries where one of your 
conditions contains the word "and" – for example, the 
publisher "Faber and Faber", you must add the quotation 
marks manually so that your meaning is clear to Access. 
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Running a Query 
When you're satisfied that you've got your query conditions right, 
test it out. With the query still displayed on screen: 

 In the Toolbar, click on the Run button. 
Having seen the query results, you may want to modify the query 
conditions: 

 Click on the Design button (left of the Toolbar). 
Where you have a number of specific queries which are "variations 
on the same theme", you will often want to flip to and fro between 
modifying and viewing your query without saving each variation. 

Saving a Query 

 In the Toolbar, click on the Save button; or from the File 
menu, select Save. 

You haven't yet given a name to this query, so a "Save 
As" box will appear. Bear in mind the same points as 
when naming a table. (page 9). 

You can now run or modify this query whenever you want: 
 In the database window, select the Queries tab. To run the 

query: double-click the query name or click the Open button. 
To modify the query: select it then click the  Design button. 

Copying Queries 
It’s often useful to copy a query so that you can use it as the basis for 
a new one, rather than redefining all the fields to include, criteria and 
so on from scratch.  

To save a copy of a query within the same database file:  

 Make sure the query you want to copy is open, or selected in 
the Database window. 

 From the File menu, select Save As, and give your query a 
new name. 

To export a copy of a query to a different database file:  

 Make sure the query you want to copy is open, or selected in 
the Database window. 

 From the File menu, select Export. The Export Query 
window will open. Select the Access .mdb file you 
want to export to. You can only export a query into a 
another Access database if it's saved in the same 
version of Access. (See page 31.)  

 Exporting to other software formats (for example Excel or 
dBase) only exports the query results, not the query design. 
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Using Parameters in Queries 

Querying of a database often involves "variations on a theme". In our 
booklist example, on one occasion the user may want to list all titles 
published by Methuen; and on another, all titles published by 
Penguin. Rather than continually returning to the query design 
window to modify the query, it makes more sense for the user to 

"pass a parameter". All this means 
is that Access will prompt the user 
to specify a value – in our example, 
for the variable Publisher. This 
value will then be passed in to the 
query. The example shows a 

parameter query which does this. 

 In the field where you want the user to specify a value, type 
the text which you want to appear in the user prompt. 
Enclose this in square brackets.[] To avoid confusing Access, 
the prompt text shouldn't be identical to the field name. 

For a simple parameter query, this user prompt in square brackets is 
all that you need. 

Running a parameter query 

 In the Toolbar, click on the Run button. An Enter Parameter 
Value dialog box will appear, with the prompt you specified. 

 Enter an appropriate value, and OK. 

The selected data will now be displayed. When you're happy that 
your query does the right thing, don't forget to save it (page 21). 

You can create parameter queries which prompt the user for more 
than one value. You would want to do this, for example, if you used 
the Between...And operator in a parameter query. You might want to 
set up a query on the Booklist where the user could view all books 
published between any two dates they specified. The criterion would 
look like this: 

Between [Earliest Date] And [Latest Date] 
You can use wildcards (page 19) in a parameter query - to find out 
how, type Parameter Query in the Ask a Question Box (top right of 
the Access window), then select Create a Parameter Query.  

Converting between select and action queries 

When using action queries (page 16), it's always advisable to start 
with a select query and check that this correctly selects the records 
which you want the action to apply to. Queries can easily be 
converted while open between one type and another. Always make 
a backup copy of your database before you run an update, 
append or delete query - you can't undo the results. 

 In the Toolbar, click the arrow by the query type button, 
and select the type of action query you want from the list. 
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Formatting & printing out your Data 
You can make a printout of your data straight from a table or a query. 
However, the formatting options available to you if you do this are 
limited. If your table includes memo fields, or particularly long text 
fields, you may find that it’s impossible to set it up to print straight 
from a table or query without those fields being truncated. 

When you're printing from a database, it's usually best to create a 
report, which gives you much more control over page layout, and 
allows you to group data in the printout. When you are working with 
numerical data, this also means that your report can include 
automatically generated subtotals or other calculations. See page 25. 

If more than one printer is available from the computer where 
you're working, select the correct one from Printer Setup 
before you prepare your file for printing. Changing printer 
can make a significant difference to what fits on the page. 

If you move an Access file between different computer setups 
(for instance between home and work or college) bear in mind 
that things may look very different if the fonts used aren't 
available on both computers. 

Changing type style and size 

Formatting selected text doesn't work in Access as it 
does in other Office software. 
You might expect that you could format different columns of 
your datasheet separately. For instance in our booklist example, 
you might want the titles to be printed in italic; or set the date 
column so that it’s aligned left instead of right. You need to 
create a report or copy and paste to a Word table to do this. 

To make global changes to the entire datasheet: in Access 2002/3, a 
datasheet formatting toolbar is available. 

 Open your table in datasheet view. From the View menu, 
select Toolbars, then Formatting (Datasheet). Use these 
tools as you would in Word, bearing in mind that all 
formatting you apply will affect the entire datasheet, and can't 
just be applied to selected items. 

In earlier Access versions, you have the same control over datasheet 
formatting, but a toolbar isn't available. Use the Format menu items 
instead. 

Arial Narrow, 10pt, is a good choice for compactness 
and readability when working with tables. 



Hiding and Showing Columns 

Hiding a column or field in your datasheet view means that it won't 
display or print until you show it again. This doesn't delete the data. 

1. Display your table in datasheet view. 

2. Right-click on the title bar at the top of the field column 
you want to hide from view. This selects the column and 
opens the popup menu in one action. 

3. From the popup menu, select hide columns. 

Notice the other options available to you from the 
shortcut menu when you right-click. As with most 
Windows software, the right mouse button plays an important 
part in providing quick access to the commands you're currently 
most likely to need. Experiment! 

To restore a hidden column: 
1. From the Format menu, select Unhide Columns. 

2. In the Unhide Columns window, make sure all the fields you 
want to display are ticked, and Close. 

Hiding Gridlines; changing background colour 

You can set gridlines to different colours, or not to show at all. 
By default, an Access table will print with gridlines displayed. 
To change this: 

 From the Format menu, select Datasheet (Access 97: 
Cells). Click off the ticks under Gridlines Shown if you 
don't want any gridlines displayed. You can also change 
background colour for your datasheet from here. 

Printing direct from a Table or Query 

Where you want a standard datasheet (multiple-column layout), it 
may not be necessary to create a report. 

1. Make sure you're looking at your table or query in Datasheet 
view. Check that the data is filtered and /or sorted exactly as 
you want it to appear in the printout. Resize table columns if 
data is truncated in your onscreen view. 

2. Many tables look better if you change your page 
orientation from portrait (long and thin) to landscape (short 
and wide). To do this: from the File menu, select Page 
Setup, click the Page tab, and select Landscape.  

3. Always check in Print Preview before printing. By 
default, Access will commonly "tile" the columns in your 
table over two pages. You may need to change orientation, 
hide unneeded columns, or reduce type size to avoid this.  
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Using a Report for Printing Data 

A report can be based either on a table, or on a query. 
Reports give you much more flexibility over data layout than 
printing straight from a datasheet view. Once you have created a 
report, you can save it and use it at any time to print out an up-to-
date version of your table or query data. 

Creating a report with Autoreport 

For a simple report including all fields in standard form layout: 
1. Open your table or query in datasheet view, or highlight its 

name in the database window. 

The Toolbar New Objects 
button is context sensitive – 
it will change to show the 
most recently created object 
type. 

2. In the Toolbar, click the arrow by the New Objects button, 
and select Autoreport from the popup menu. 

If you're lucky, Autoreport will give you almost but not quite the 
layout you want. You will probably wish to add a heading, and 
perhaps leave some fields out of the report. (For example, an 
autonumber field.) If so, take the Autoreport as your starting-point 
and modify it – see page 27; or use the Report Wizard instead. 

Using the Report Wizard 

If you know at the outset that you want something more customised, 
the Report Wizard allows you to exercise some control over what 
you start with: what fields you use, what order they appear in, how 
they are laid out and grouped. As with Autoreports, you can easily 
modify the layout later on to suit your needs.  

 In the Database window, click the Reports tab. In Access 
2002/3, double-click Create Report by using Wizard. (In 
earlier Access versions, click the New button, then select 
Report Wizard.) 

The Report Wizard dialog box will appear.  

1. From the Tables/Queries picklist, select the table or query 
you want to base your report on. 

2. Select the fields you want to include in your report. Use the 
>> button to add all fields, then remove any you don't want 
with the < button. Highlight and add one-by-one with the > 
button if you want to change their order on the report. Click 
Next when you have selected the fields you want. 

3. If you want your report to be grouped by a field, select the 
field you want to group by from the picklist on the left. In the 
example, the booklist will be grouped by publisher. 
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4. You will now be asked what sort order you want for 
your records. Whether or not you have also grouped your 
records by a field, you are likely to want to print them in 
sorted order. In the booklist example, you might have 
chosen to group by publisher, and within that want to sort 
in alphabetical order of author's name. Within that again, 
you could have each author's books ordered by date of 
publication – to do this Author should be the field selected 
in the first "Sort By" box, and Date in the second box. 
When you have specified the Sort fields: 

5. Click on the Next button, and specify how you would like 
to lay out your report. Try out the different options – the 
preview window will show you the effects. 

 Usually, you will want to leave Adjust the field 
width so all fields fit on a page switched on. If you 
click it off, your columns may be tiled across more 
than one sheet of paper. 

 Check that page orientation (page 24) is set as you 
require, then click on Next. 

6. Try out the different style options for your report (not 
illustrated), and click on Next.  

7. You have now arrived at the last step of the Report 
Wizard. Provide a title for your report. 

 Click on Preview the report to check its 
appearance, then Finish. 

Our example Booklist report created with 
the wizard will look like the illustration. 
Long entries in the Title field have been 
truncated, and spacing between fields could 
be improved. But this can be easily adjusted 
once the report is saved - see the next page. 

 In the Menu Bar, click on File, then Save As. 
Enter an appropriate name for your report (this can 
be up to 64 characters long), and click OK. 

Saving a form as a report 
You can save a form (see page 13) as a report – if you have put 
some work into customising a form layout for data entry, this can 
avoid a lot of duplicated effort. 

 In the database window, click the Forms tab, then 
highlight the name of the form you want to base a report on. 

 From the File Menu, select Save As.  Under As, select 
Report. Once saved, make any layout adjustments required 
(p.27). In Access 97: right-click on the name of the form you 
want to base a report on. From the popup menu, select Save as 
Report. 
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Improving Form and Report Layout 
The methods by which you modify Form and Report layouts are 
mostly identical, but with Reports you have some additional features. 
In particular, these allow you to use functions for printing 
information such as current date, totals and sub-totals automatically. 

 If you have created a report using Autoreport or Report 
Wizard, it will automatically be displayed in Print Preview 
mode – you can't edit it in this view. If you want to make 
modifications, click on the Close button. You will be taken to 
the Design Window. 

 If you have saved a form or report which you now want to 
modify: in the Database Window, highlight the name of the 
Form or Report which you want to modify, then click on 
Design. The Form or Report Design Window will open. 

Understanding the Design Window 
In any report or form design window, you'll see boxes containing 
headings, field names, field contents etc. The rulers and the layout 
grid allow you to quickly align these different objects in the report 
or form. Example 1 shows what the sample report created with the 
Report Wizard (see previous page) looks like in Design view. 
Notice how the window is divided into horizontal sections: 

Report header: for a title on the first 
page. 
Page header: for headings to be 
repeated at the top of each page. 
Group header: (in the example, 
Publisher Header) – contains the name 
of any field you have grouped by. 
Detail: where the data for each record 
is displayed. 
Page footer: for footers at the 

bottom of each page. In the example, the Report Wizard has 
automatically included two functions – Date and Page x of y in 
the footer area.  

Example 1: Wizarded Report 
in Design View. 

Example 2: Autoform in 
Design View. Report footer: for a "final sign-off" at the end of the report. 

Example 2 shows an Autoform in the Design window. 
Only a Detail section is initially included -you need to add a 
form header section if you want to give the form a title (see 
page 30). In this single-column layout, both Field names 
and Field contents are contained within the Detail section. 
Compare this with the multiple-column report layout above, 
which contains the field names in a page header area 
separate from the details area, and where the field contents 
are laid out along one row.  

Field contents Field names 
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Controls 

Think of the items laid out in your design window as a set of different 
objects – various headings, field names, field contents boxes, and 
functions. Each object is boxed in what Access calls a control.  
Once you have selected a control or controls, you can move them or 
size them to improve your report or form layout. You can format the 
text to whatever type size and style you want. You may also want to 
delete some controls – for instance any fields or field names you 
don't want to include. Where controls are labels (for instance 
headings or field names) rather than data items, you can also edit the 
text. 

Selecting and moving controls 
 Click on any control to select it. Handles (black boxes) will 

appear around its borders. 
 To select more than one control: hold down the Shift key 
while you click on each one. 

 To select all the controls within a report or form section: 
move the cursor until it's within the vertical ruler bar next to 
the section. Click when the cursor changes to a black arrow. 

Cursor 
If you are using a standard form layout, or a report layout where the 
field names and field contents appear together in the details section, 
you'll notice that when you select a field name control a handle will 
also appear on the field contents control, and vice versa. Access gives 
you the option of moving linked controls together, or separately.  

 If you point the cursor at the top left handle of a selected 
control, it will change to a " single pointing finger" shape and 
only that control will be moved when you click and drag. 

 If you point the cursor anywhere at the border of a selected 
control except at a handle, it will change to a "flat hand" and, 
if the selected control is linked to another one, both controls 
will move when you click and drag. 

As you are moving a control or controls: 
 Watch the black highlighted areas in the ruler bars which 

show the current position of the objects being moved. 
 If the ruler bars don't show: from the View menu select Ruler. 

Resizing Controls 
You may need to change the amount of space which has been 
wizarded for headings, field names or field contents. 

 Select the control or controls you want to resize. Move the 
mouse over any handle except the top left one. When the 
cursor changes to a two-way arrow, click and drag. 
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Changing type style and size 
When a control is selected, the Toolbar changes so that the tools for 
changing font, size, alignment and colour are available just as they 
are in Word. There are also some extra tools on the right for adding 
borders and special effects to a control. Run the mouse slowly over 
the toolbar to see the tool tip telling you what each button does. 

Adding text, lines and boxes 

 Extra tools for formatting reports and forms are available in a  
toolbox, normally located at the left of the window. If this isn't 
visible on screen: in the Toolbar, click the Toolbox button. 

 To add a heading or other text item to your report: click the 
toolbox label button. The cursor will change shape as 
illustrated. Click and drag to draw a box to contain your 
heading, then type within this box and format as usual. 

 Use the line and rectangle tools at the bottom of the toolbox 
if you want to add lines or boxes to your form or report. Select 
your line or box and use the tools at the right of the toolbar to 
modify line colour and width, or add special effects. 

The toolbox contains a variety of tools which permit far more 
complex form and report design than is covered here. In Contents 
Help, look at the topics available under Controls and Charts. 
(Access 97: Working with Controls on Forms and Reports.) 

Resizing sections and the overall form/report area 
If you have moved or resized controls within a section, you will often 
need to add extra vertical space within that section to accommodate 
your changes. Or, for example, you may want to reduce or increase 
the space between records by resizing the Detail section. 

 Move the mouse so the cursor is over a section division. When 
the cursor changes to the shape illustrated, click and drag. 

If you want to resize the overall report or form area: 
 If necessary, enlarge the design window so that the blank 

space available for you to extend into is visible. 
 Move the mouse over the form or report boundary. When the 

cursor changes to the shape illustrated, click and drag. 
 If you're modifying a report, watch the ruler bar to make sure 

you aren't extending the width of the report beyond the paper 
size you're using. Remember to allow for margins. 

 You may need to adjust margins to accommodate the width of 
a report. For instance, if you extended the report area width to 
17 cm, to print on A4 paper (21 cm wide) left and right 
margins would need to be a maximum of 2 cm each. Change 
margins and page orientation from File | Page Setup. 
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Adding or deleting header and footer sections 

You'll need to do this if you have created an Autoform and want to 
add a title – when the form or report is first displayed in Design 
view, there will be no Header section to place this in. 

 Right-click anywhere within the form or report area, but not 
on a control. The shortcut menu will appear. 

 Page Header/Footer and Form (or Report) Header/Footer 
are near the bottom of the menu. Make sure you're clear about 
which you want (see page 27). Click on, and a new section will 
appear in the design window. Click off, and that section will be 
removed – including any controls you have placed within it. 

Aligning controls 

When you start moving controls around or resizing them, you're sure 
to have problems getting them properly lined up with each other 
again. Get things roughly in place by eye, then use the Align tool for 
fine adjustment. 

 Hold down the shift key while you click on the controls you 
want to line up with each other. 

 Right-click on the mouse, select Align from the shortcut 
menu, then select alignment type. 

 Notice the other commands which you can reach 
from the right mouse button. You may find this 
quicker than using the Toolbar. 

An example modification 

The starting-point was a Report Wizard (page 25). 
 The page header section containing field name 

controls has been deleted. "What's what" is self-
evident from the field content. 

 The Title field has been formatted bold italic. 
 The Summary field is a smaller size text. 
 The Detail controls have been repositioned so 

that Author and Date share a line, with Title and 
Summary each on a new line. The width of the 
Title control has been extended so it doesn't 
truncate. 

 Controls in the Details section have been moved 
so there is less vertical space between them. 

 The Details section has been resized so there is 
less space between each record. 
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Importing and Exporting Data 

Transferring between different Access versions 

 Always make a backup copy of important database 
files, before opening in a different software version. 

An Access 97 file can be opened or converted in all later versions. 
Access 2000/2002/2003 are set by default to save files in the Access 
2000 file format. This means that, unless the setting has been 
changed by the user (or, on centrally-administered networked PCs, 
the network administrator), no difficulties should be encountered in 
moving files between Access 2000-2003. 

 When you have a file open in Access 2002/3, the title 
bar of the database window tells you what format the 
file has been saved in. 

If your file is not in Access 2000 format, before you copy your file 
for transfer you will need to use the Access Convert Database 
utility. Conversion to Access 2000 format creates a file which will 
open in all versions from 2000-2003. If you want to transfer your file 
to a PC running Access 97, you must convert from here to 97 format. 

Converting to Access 97: 
points to watch for 
If you have used the 
decimal number type and 
want to open your database 
in Access 97 - change the 
number type to Double 
before conversion. Apart 
from this, problems are 
much more likely to arise for 
advanced database users 
working with complex 
relational databases and 
databases which include 
modules. 

To convert to a different format: 
1. From the Tools menu select Database Utilities | Convert 

Database. Select the required Access version. 

2. When you convert you must specify a new filename and/or 
file location - the converted file can't replace the original. 

If you have used any features which weren't available in an earlier 
Access version you are transferring to, they won't be correctly 
handled. If you're converting to Access 97, see the side panel.  

Opening an Access file without converting 
In Access 2000-3, you can choose between 
Converting or simply Opening a database. If 
you only want to view, add or modify database 
records, conversion isn't necessary. This is 
mainly useful if you want to open an Access 97 
file in a later version, and then still be able to 
open the file again in Access 97. The limitation 
is that you can't make design changes to a 
database Organise your work so that you make 
any necessary design changes to tables, forms 
or reports in your database while it's open in the 
earlier Access version.  
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Importing data from Word and Excel 

It's possible to copy and paste data from a Word table or an Excel 
spreadsheet straight into Access. But to do so, you must first have 
created an Access table structured so that the number of fields and 
field width correspond to the columns in the data you are pasting. 

It's almost always easier to use the Import Spreadsheet wizard, 
which automatically creates a table to receive the data. If the data 
you want to load into Access is held in a Word table, copy and paste 
it into Excel first so that you can use the Wizard.  

1. Make sure all the data you want imported to Access, and only 
that data, is on a worksheet by itself. This should consist only 
of data columns, and column headings – not main titles, charts 
etc. Move or copy data to a new worksheet if necessary. 

2. If your data includes date or time columns, make sure that 
these are formatted to the correct data type before importing 
from Excel. Select the relevant cells, then choose the 
appropriate option from Format | Cells | Number. 

3. Save and close the Excel worksheet before importing. 
4. Make sure the database in which you want to store the 

imported data is open in Access. 
5. From the Access File menu, select Get External data, then 

Import. The Import window will open. Set Files of Type to 
Microsoft Excel, select your file, and click Import. 
6. The Import Spreadsheet wizard will open. Select the 

worksheet which contains your data, and check that the 
sample data displayed looks correct.  
Cancel if the sample doesn't look as you expect, and 
return to Excel to set up your data correctly. Otherwise, 
click the Next button to carry on to the next step.  

7. Specify whether or not the first row of your data contains 
column headings – if this is checked, the first row will 
be used to supply field names automatically. Click Next. 

8. Select whether you want the data stored in a new table or an 
existing table. If you want to import the data into an existing 
table, the structure of that table must be correctly set up for the 
data you're importing - for this reason it's normally easiest to 
import the data into a new table.  

9. If you want to change field names, or omit any fields from the 
table, make these changes.  

10. If the table already has a primary key, select it. Otherwise, let 
Access add a primary key for you. (See page 9.) Click Next. Comma-delimited text: a 

simple way of defining a 
table in text-only format. 
Fields are separated by 
commas. If there are 
commas within a field, the 
data in that field must be 
placed in inverted commas 
to avoid confusion. 

11. Give the table a name, then click Finish. 

 Use File – Get External Data – Import to import tables 
from other standard database and spreadsheet formats; text 
(e.g. comma-delimited) files and HTML, as well as Excel. You 
can also import tables from other Access databases. 
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Linking external data 

If external data is linked rather than imported, you can work with the 
data, without making it part of the current Access database. Link 
rather than importing when you want to: 

1. Use a table stored in a different Access database file, in 
conjunction with tables in the database you're working from. 
Access doesn't allow you to have more than one database open. 

2. Use Access as a "front end" for working with data which is 
stored in a different software format. 

In these cases, linking avoids the serious confusions which arise if 
you have duplicate working copies of the same data – which is to be 
treated as the "master" table? To link a table: 

 From the File menu, select Get External Data, then Link 
Tables. Set Files of Type to the correct software format, 
then carry on as when importing tables. 

Exporting data by copying and pasting 

To copy or paste into Word or Excel: 
1. Open your table or query in datasheet view and check that 

what you're displaying is exactly the data you want to export. Select all button 
2. Select the data you want to copy. To highlight the whole 

datasheet: click on the Select All button in the top left corner. 
To select a block of adjacent records, click in  the button bar 
by the first record in the block, then hold down the Shift key 
while you click the bar by the last one. In Access, you can't 
use Ctrl + Click to select non-adjacent records. 

3. In the toolbar, click the Copy button. 
4. Open your Word or Excel file, and click where you want the 

data to be pasted. 
5. In the toolbar, click the Paste button. 
6. You may need to make adjustments to column width and/or 

row height, especially if you have pasted into Word. Word 97 
doesn't behave nearly so well as Word 2000-2003 in this 
respect, but normally the options available from the Table | 
Autofit menu will put things right without difficulty. 

The example was copied 
and pasted from Access to 
Word as described above. 
Be warned that Word 
doesn’t handle large 
tables well – it’s best to 
print direct from Access. 

Author Title Publisher Date Summary 

Berg, Maxine The Age of Manufactures, 1700-1820 Fontana 1985 Eighteenth century economy – vital 
transition between pre-industrial and 
industrial economies. 

Briggs, Asa Victorian Cities Penguin 1968 1st pub 1963. Concentrates on 
Manchester, leeds, Birmingham, 
Middlesbrough, London, also 
Melbourne, Australia. 

 Use File – Export to export tables to dBASE, FoxPro, and 
HTML, as well as Excel. The procedure is straightforward.  
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Relating tables within a database 
Linking tables to one another to create a relational database is often 
useful. Designing such a database can be complex and you will need 
to understand some theory. All this section does is to look at some 
very basic issues. 

To relate two tables, they must share a common field or fields. These 
fields must be of the same type, and should be the same length. It's 
simplest if common fields share the same name. 

When you create a relationship between two tables, one table is 
the primary table, and the other is the related table. The primary 
table should have the common field as its primary key. 
Page 9 explains about defining primary keys. 

In our example database, a bookseller might want to relate the 
booklist table to a table containing publisher details, on the common 

publisher name field. (For instance, for stock 
ordering purposes.) The publisher table will 
be the primary table, with the publisher name 
field as its primary key. It has a one-to-many 
relationship with the booklist table – for one 
publisher, there will be many books listed. 

Often, an autonumber field will be used to 
provide a unique ID as the primary key for the primary table, and this 
ID will be entered as the common field in the related table.  For 
example, a shop might keep a Customer Details table containing 
customer name, address, and a Customer ID number. In a separate 
Orders table, Order details could then be linked to Customer details 
by including the Customer ID for each order. One customer may 
place many orders – using linked tables means that you don't 
repeatedly have to enter the customer details in each Order record. 

A new feature in Access 2002: 
once a relationship has been 
created between two tables, 
you'll see +  buttons by the 
side of each record in the 
primary table. Click the + sign 
to view the related records - 
you can edit and add new 
records from here if you wish. 

Before you begin... 

1. Make sure that the tables you want to link have a 
common field with the same name and data type, 
and that this is defined as the primary key in the 
primary table. If the primary key is an autonumber, 
make sure the data type is set to long integer. 

2. Be clear about what type of relationship you 
want to create. If you see the relationship type 
described as indeterminate when you are creating a 
relationship between tables, cancel what you're 
doing and make sure you followed step 1 properly. 

Relationship types 

3. Be clear in advance about the type of join you 
want to create – the different join types are shown 
on the left. The default – what you get if you don't 
change it – will normally be type (1). 

Join types 
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Creating a Relationship 

You can specify a relationship permanently between two tables, or 
temporarily within a query. To create a permanent relationship: 

 Close any open tables or other database objects, leaving only 
the Database Window open. 

 In the Toolbar, click the Relationships button. 

The Show Table window should open. If not, 
select Relationships from the menu, then Show 
Table. Notice that you can relate queries in just the 
same way as tables if you wish. 

 Select each table you want to relate, and click on Add. 

 Click Close when you have finished adding tables.  
The relationships window will now appear: 

 Highlight your primary key and drag across to the related 
field. The cursor will look like the illustration. 

 In the dialog box which appears, check that the relationship 
type is as you expect, and that the correct join type is selected 

(see previous page). You can also enforce 
referential integrity if you wish. 

Referential Integrity is an important concept in 
relational database management. When you have two or 
more linked tables, you can seriously screw things up if 
you break links by deleting or editing a record in one 
table, without deleting or editing linked records in another 
table – this is known as leaving "orphan records". If 

Referential Integrity is enforced, Access will prevent you from 
deleting or editing a primary record upon which related 
records depend; or from adding records where there is no 
related primary record. Not all table structures will permit this. 

 Click the Create button, and the linkage between tables 
should be illustrated in the Relationships window as shown. 

Setting Relationships in Multiple Table Queries 

You can set relationships "on the fly" while you are building a query. 
You can relate more than two tables, but the more tables you link, the 
slower the query will process. Linking queries rather than tables for 
complex linkages can speed things up considerably. 

 Add all the required tables or queries to your current query. 
 Click and drag to define the relationships as described above. 

The information given above is intended only as a "taster" of what's 
involved in creating relational databases. This is a topic which most 
people would find difficult to teach themselves either from online help 
or books. A structured course is emphatically the best way to learn. 
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Tips and traps 
Compacting and repairing databases 
Compacting a database will never do it any harm! Always do this 
when you have deleted items from a database. The overall 
file size may not decrease as a result of your deletions until you 
compact – this is especially important if you have included and then 
deleted any pictures from your database. Access 97: 

Compact and Repair are 
two separate commands 
from the Database Utilities 
menu option. If you're 
using 97and your 
database is showing signs 
of corruption, Repair first 
and then Compact.  

An Access database file has a highly complex structure, and it may 
occasionally become corrupted. In addition to using the Compact and 
Repair utility to reduce file size after deleting records, run it if you're 
experiencing problems of any kind with your database file. 

 From the Tools menu, select Database Utilities, then 
Compact and Repair Database. 

Including pictures in databases 
Using pictures to improve form and report layouts 

1. Open your form or report in Design View. Click in the section 
where you want the picture to appear. (See page 27.) An image 
placed in the Detail section will be repeated with every record. 

2. Don't copy and paste pictures into Access – it can make your 
database file much larger than necessary. Save the picture to 
file, and use the Insert | Picture menu command. 

3. The inserted picture will appear in the design grid. Use the 
picture control handles to move or resize (page 28). 

4. If you want to use the picture as a background image: select 
the picture. From the Format menu, select Send to Back. 

Using Access to store pictures 
Using Access to create a database for storing pictures isn't a simple 
project. These are just initial points to consider: 

 Pictures can be stored within a database table if you have 
defined a field of the OLE object data type. However, a 
database file containing a lot of pictures may become very 
large and liable to corrupt. As a general rule, this approach 
should only be used if your database contains a very small 
number of records. Pictures stored as OLE objects will display 
in Forms or Reports, but not in datasheet view. 

 An alternative is to organise picture files in a separate folder 
and define a hyperlink field in your table. You can then 
specify links to your picture files. You'll need to double-click 
the hyperlink to display your images – this can be done in 
datasheet as well as form or report view. If pictures are linked 
to a database file which you want to transfer to another 
location, the picture files must always accompany it.  
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DOCUMENT CROSS-REFERENCE TO 
EUROPEAN COMPUTER DRIVING 
LICENCE (ECDL) SYLLABUS 

The ECDL is an internationally accepted certificate of 
computing competence. The purpose of the table below is to 
set out what ECDL Database module requirements are; and 
to indicate how the content of this document maps to these 
requirements. This document can be used as a 
supplement to ECDL learning materials, but not as a 
replacement. You need experience in traffic before you can 
pass a driving test; in the same way you'll need practical 
experience of working with a fairly substantial database. 
Items are marked with an asterisk * where this is particularly 
important to bear in mind. 

Some topics are covered in greater depth by this document 
than is required by the ECDL syllabus. This applies 
particularly to database querying. The information about 
importing and exporting data and relational databases isn't 
covered in the ECDL syllabus. 

 

ECDL Syllabus No. 3: Module 5 - Database Page no. 
5.1 Getting Started  
5.1.1 First Steps with Databases  
5.1.1.1 Open a database application. 4 
5.1.1.2 Open an existing database with default 
layout. 

4 

5.1.1.3 Modify a record within an existing 
database and save. 

*12 

5.1.1.4 Save a database onto the hard disk or 
a diskette. 

5,7 

5.1.1.5 Close the database. 7 
5.1.1.6 Use application Help functions. 5 
5.1.2 Adjust Basic Settings  
5.1.2.1 Change viewing modes. 10 
5.1.2.2 Modify toolbar display.  Not 

covered 
5.2 Create a Database  
5.2.1 Basic Operations  
5.2.1.1 Design and plan a database. 6 
5.2.1.2 Create a table with fields and 
attributes. 

7-9 

5.2.1.3 Navigate throughout a table. *14 
5.2.1.4 Enter data in a table. 12 
5.2.2 Define Keys  
5.2.2.1 Define a primary key. 9 
5.2.2.2 Set up an index. 9,11 
5.2.3 Table Design  
5.2.3.1 Modify table layout attributes. 12 
5.2.3.2 Modify field attributes. 10-12 
5.2.4 Updating a Database  
5.2.4.1 Modify data in a table. *12 
5.2.4.2 Delete data in a table. *12 
5.2.4.3 Add records to the database. *12 
5.2.4.4 Delete records in the database. *12 
5.3 Use of Forms   
5.3.1 Create a Form   
5.3.1.1 Create a simple form. 13 
5.3.1.2 Enter data into the database using 13 

simple forms. 
5.3.2 Modify Form Layout  
5.3.2.1 Format text 13 
5.3.2.2 Change background colours in form 
layout. 

13 

5.3.2.3 Import an image or graphics file into a 
form. 

36 

5.3.2.4 Change arrangement of objects within 
form layout. 

28 

5.4 Retrieve Information  
5.4.1 Basic Operations  
5.4.1.1 Load or log onto an existing database. *4 
5.4.1.2 Find a record based on given criteria. *14 
5.4.1.3 Create a simple query. 15,17 
5.4.1.4 Create a query with multiple criteria. 20 
5.4.1.5 Save a query. 21 
5.4.1.6 Add filters. 14 
5.4.1.7 Remove filters. 14 
5.4.2 Refine a Query  
5.4.2.1 Add fields to a query. 17 
5.4.2.2 Remove fields from a query. 17 
5.4.3 Select and Sort  
5.4.3.1 Select and sort data based on given 
criteria. 

14,17 

5.4.3.2 Select and sort data based on common 
logical operators. 

15,19 

5.5 Reporting   
5.5.1 Create Reports   
5.5.1.1 Present selected data in a particular 
sequence on and in reports. 

25 

5.5.1.2 Modify a report. 27-30 
5.5.1.3 Create and customise Headers and 
Footers. 

30 

5.5.1.4 Group data in a report-totals, sub-totals 
etc. 

Not 
covered 
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Access, transfer between versions 31 
Action queries 16 
And operator 18 
Autoform 13 
Autonumber data type 8,34 
Autoreport 25 
Between operator 20 
Compacting databases 36 
Comparison operators 16 
Contains conditions 19 
Controls, moving 28 
Controls, resizing 28 
Controls, aligning 30 
Controls, defined 28 
Criteria 18 
Currency data type 8 
Data types, defined 8 
Date/Time data type 8 
dBASE - importing & exporting 32,33 
Entering data 12 
Excel, moving data to/from 32,33 
Exporting data 33 
Field, defined 6 
Field Description 8 
Field display widths, adjusting 12 
Field Name 8 
Field Order, changing 10 
Field size 11 
Fields, inserting 10 
Fields, deleting 10 
Fields, renaming 10 
Fields, showing and hiding 24 
File names 7 
Filters 15 
Fonts 23,29 
Form Detail 27 
Form Headers 27 
Form Wizard 13 
Forms, creating and using 13 
Functions 27 
Graphics, including 35 
Importing data 32 
In operator 20 

Like operator 19 
Linking external tables 33 
Long fields, displaying 12 
Memo data type 8 
Multiple table queries 35 
Not operator 20 
Number data type 8 
Number type settings 11 
OLE objects 8,36 
Parameter queries 22 
Pictures 36 
Primary Keys 9,34 
Print Setup 23 
Queries, building 17 
Queries, selecting fields 17 
Queries, running 21 
Queries, saving 21 
Referential integrity 35 
Relational databases 3,9,34-5 
Relationships, creating 34-5 
Repairing databases 36 
Report Detail 27 
Report Footers and headers 27,30 
Reports, creating 25 
Searching data 14 
Select queries 16-22 
Sort order, in queries 18 
Table design view 7 
Tables, naming and saving 9 
Tables, modifying structure 10-11 
Tables, Word 32-33 
Text data type 8 
Toolbox 29 
Type formatting, reports 29 
Type formatting 23 
Unique identifiers 9 
Updating, with queries 16 
Wildcards 19 
Wombats 19,20 
Word, moving data to/from 32-33 
Yes/No data type 8 

 

Further references 
Companion documents include Making IT happen with MS Word; Making IT 
happen with MS Excel 2002. 
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